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PREFACE

AEOSS is a specially tailored software coded within the framework of the relational database
program of the Acius' 4th Dimension with an Apple Macintosh version. It enables users to
predict the required power, weight, and cost for a generic Earth-orbital spacecraft system.
These variables are calculated on the component and subsystem levels, and then the system
level. Selected performance analyses for essential components and subsystems are provided.
The costs are assessed using statistically determined cost models of the flown spacecraft that
were categorized into classes in accordance with their functions and structural complexity.
This software has the feature permitting a user to enter totally or partially known values of
these parameters at all levels. Such capabilities warrant the results to be realistic and
reliable. All information is of vital importance to project managers of the spacecraft
subsystems or a spacecraft system.

Prompted by the licensing agreement with the Acius, Inc., two versions of the software
associated documents have been prepared. They are:

(1) AEOSS Runtime Manual - A finite number copies of the restrictive 4D Runtime version
are permitted, through a licensing agreement, to be distributed with the developed AEOSS
database sofeware. This version does not allow a user to make any changes of the program
structures nor to alter any program procedures; it is fully capable of running all contents
of the applications.

(2) AEOSS Design Guide - This version is for users to exploit the full capability of the 4th
Dimension. It is for an advanced user or a programmer who wants to alter or expand the
program structures, the program statements, and the program procedures. However, the
user has to possess a 4th Dimension first.

Thanks are due to the staffs of the ATR, Inc. who provided the coding efforts. Specifically, to
Peter Hui who assisted in searching an appropriate relational database software suitable for the
intended applications, and in mapping the conceptual architecture of the program; to Livia Zien
who brought this program into being and furnished the document related to the preliminary
version; to Ronald Yurow who made final corrections and revisions to assure this
accomplishment to be a viable and valuable tool.

_o

iii

PRE_EI_ii'=,_3 P,_54_EBLANK NOT F!LMEL)





AEOSS Runtime Manual
for operating In the Custom Environment

I. INTRODUCTION

The Advanced Earth-Orbital Spacecraft Systems (AEOSS) database is a specially
tailored software coded from the relational database of 4th Dimension (Ref. 1). It permits
the user to determine the power consumption, weight, and cost for a spacecraft system. The
interested parameters are common to all spacecraft and can be calculated on the component or
subsystem level and then the system level. The flexibility of permitting the user to enter
known values, total or partial, of these parameters at different levels adds another dimension
to this software capability. Performance analyses for a number of essential components and
subsystems are also provided. These capabilities, that were implemented on the basis of the
mathematical models or expressions and the collected data given in Reference 2, enable this
software to yield realistic and reliable results for a spacecraft system. All this information
is of vital importance to project managers of a spacecraft system.

This AEOSS Runtime is a restrictive version. It uses the 4D Runtime version that is
permitted to have a finite number copies for free distributions with this AEOSS database
software through a licensing agreement with the Acius, Inc. Although the Runtime version is
fully capable of performing all included applications, its companion version, whose manual
being the AEOSS Design Guide (Ref. 3), should be consulted if the user wishes to gain insight
to the program structures, wants to make any alterations of the program statements or the
program procedures, or has the need for supplementing any enhancements.

II. STARTING UP

To start, the user enters the AEOSS database by clicking on the AEOSS folder icon twice.
This will bring up a list of all files associated with the database. Double clicking on any of the
"start.xxx" file icons will start the program.

A password hierarchy has been built in so that a user has limited access to the three specified
environments: (1) Design, (2) User, and (3) Custom. A user who has access to the
Design environment, the highest hierarchy access, is accessible to all three
environments, including both the User and the Custom environments automatically. A
user who has access to the User environment, is inaccessible to the Design
environment but is accessible to the User and the Custom environments. The Custom

environment access does not allow the user to enter any other environments in higher
hierarchy but to itself. The Custom environment lets the user gain access to all menus
that allow the user to input or modify data and to view or delete the data already entered, but
does not allow any changes of stored database nor of the design codes except in a few special
cases.

For simplicity, the Runtime version is specially provided for users who will only apply
this database without any program changes. Its access is limited to the Custom
environment. A password is to be entered by typing in at the outset. A menubar, Menubar
#1, will appear on the screen with seven menus. It has the following form:

File Edit System Info Subsystem Data Subsystems Formats Tables



The System Info menu allows the user to input, modify, and delete data for a spacecraft at
the system level. Under the Subsystem Data menu, the user again has options to input,
modify, and delete data on parameters pertaining to any subsystems of a spacecraft. In
addition, the user can view the entered data that can also be printed if so desired. Under the
Subsystems menu, there are six defined subsystems: Electric Power, Thermal
Control, Structure, Auxiliary Propulsion, Attitude Control, and CC&DH
(Communication, Command and Data Handling). Each subsystem selected under this
menu calls up a new menubar that will be discussed later in detail.

The Subsystems menu differs from the Subsystem Data menu in that the former includes
many performance analyses of individual components as well as the defined subsystems that
require the user input for various parameters unique to the cases, and the latter, on the
other hand, requires direct user entries of summarized data, whether calculated or specified
known values, of the listed parameters for all subsystems and their components as well.
These parameters include weight, size, power consumption, temperature, and Cost.

The user first enters the system information via the System Info menu, then enters data
into the subsystem of concern under the Subsystems menu for detailed performance
analyses and, finally, enters the calculated or specified values through the Subsystem Data
menu to input data for calculating the unknown parameters. The results are entered
automatically into the Summary of S/C System that can be selected under the Formats
menu.

The Formats and Tables menus generally require no input from the user. The Formats
menu allows the user to select different layouts to be viewed or printed. The contents are
Summary of S/C system, Cost models, and the Spacecraft System totals. The
Tables menu contains: Cost Constants, the NASA Inflation Index, Physical
Constants, Weight Limits, and Modify Table. The last one is a special provision
permitting the user to expand or modify the data in several tables.

II1. FUNCTION AND OPERATION

Detailed instructions of operation for various menus are described in the following:

A. System Info Menu

The user shall first select the Input System Info from the System Info menu to
enter information relevant to the entire spacecraft system. The layout is entitled
Spacecraft Classification. The number 100 has been coded to identify the
spacecraft system under the Spacecraft ID Number. The user is to enter a name
following the title of the Spacecraft Name and to identify the Spacecraft Type --
Explorer or Nonexplorer and the Structure Class -- Simple or Complex for
a spacecraft. The corresponding values for the two constants a and b of the cost models
will be linked and displayed automatically unless the weight falls out of the ranges, then
the user will be asked to supply new data. Having entered all input data, the user clicks
on the OK button to save the record and to exit from the layout, or he can click on the
Cancel button to abort the attempt and to exit from the layout.

When modifiCations of the entered data are needed, the user can select the Modify
System Info under the System Info menu to input new values.



B. Subsystems Menu

The Subsystems menu lists all six defined subsystems of a spacecraft. Each selection
of these subsystems will lead to a new set of menus allowing the user to enter values for
various parameters through different layouts unique to the particular components or
subsystems.

For convenience, the database features an option to store frequently used constants in
some layouts to avoid repeated typing inputs. The user can click a field displaying the
title of Constant Needed to select such a constant with its proper units, and the value
will enter into the field automatically. For those layouts containing such a field, the
user can enter this field and select the values many times, depending on the number of
constants involved. A window displaying the available constants will appear on the
right-hand side of the screen for selections.

A typical example for entering these constants in the layout of the Space Radiator Design
is to enter the values of the Stefan-Boltzmann constant and the solar constant. The user
clicks on the field of Constants Needed, a name list of constants will appear in a
window at the upper right corner of the layout. A selection on the name Stefan-
Boltzmann will call up another table displaying several units. When the one having the
desired units is selected, its value will enter into the proper field automatically.
Similar procedure applies to select another value for the Solar constant.

In the performance calculations for all subsystems, some procedures are common to all
cases, and they need only be described once herein.

Under each individual subsystem menu, the user will find four selections: the Input
Data, Modify Data, View Data, and Delete Data. Any selection will call up a dialog
box that lists the available layouts that can perform specific calculations.

When data are first entered into a layout through a selection of the Input Data, only the
OK and Cancel buttons are available. The OK button will save all data shown on the
screen and exit from the layout. The Cancel button will exit from the layout without
saving any information. If data are modified through the Modify Data, there are four
buttons available at the bottom of the layout. The two additional buttons are Save and
Retrieve. The Save button will save all data appearing on the screen but will not exit
from the layout. The Retrieve button will retrieve the saved old data before the new
data have been saved. The currently saved data will replace the old ones that are
retrievable as long as the user does not exit from the layout and continues to experiment
with different values. Once the Save button is clicked, the old data are gone forever.
The data entered through the preceding five layouts will constitute one record. The
execution of the Delete Data will delete all information entered in this record. The
user will have to enter data all over again through the individual Input Data layouts.

It is not a procedural necessity but is advisable to complete data entries to all layouts of
a subsystem before proceeding to the next one.

The Quit selection under the File menu will lead the user to exit from the Menubar #2
and to return to Menubar #1, the main menu.
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1. Electric Power

When the Electric Power is selected under the Subsystems menu of the Menubar
#1, a new set of menus, Menubar #2, will appear on the screen:

File Edit Electric Power Formulas Tables

In the Electric Power subsystem, there are five listed layouts: Sunlight and
Eclipse Durations, Solar Array Sizing, Weight (Solar Panel Weight
Calculation), Solar Array Temperatures, and Battery Design.

The Formulas menu contains selections corresponding to the listed layouts, allowing
the user to view or print the underlying formulas used in computations for the
individual layouts.

The Tables menu contains a table on solar cells.

2. Thermal Control

The selection of Thermal Control under the Subsystems menu from the Menubar
#1 will show the Menubar #3 as follows:

File Edit Thermal Formulas Tables

The layouts under the Thermal menu include Simple Space Radiators Sizing,
Space Radiators Sizing, and Thermal Louvers and Electric Heaters. The
formulas corresponding to the preceding layouts are included under the Formulas
menu with the same titles. The Tables menu contains five tables of thermophysical
properties of the absorptivity and emissivity of various coatings.

3. _;tructure

The seleciion of_Structure under the Subsystems menu from the Menubar #1 will
show the Menubar #4 as follows:

File Edit Structure Formulas Tables

Structural analyses on static performances and dynamic responses depend on large
scale main-frame computer programs, such as the NASTRAN. Two important post
analysis determinations are included: (1) The determination of the Direction of ith
Mode, and (2) Margin of Safety. The former uses the NASTRAN results of the
calculated SPC forces (Forces of single-point constraint); the latter makes use of the
NASTRAN-generated stress results and the related material property data.

Nothing is currently stored under this Formulas menu. The Tables menu contains a
table of yield stresses for some aerospace structural materials that will be used, for
instance, in determining the margin of safety.



4. Auxiliary Propulsion

The selection of the Auxiliary Propulsion menu from the Menubar #1 will call up
a set of menus in the Menubar #5 as follows:

Fi le Edit Auxiliary Propulsion Formulas Tables

There is only one layout or performance analysis associated with this subsystem. It is
a detailed analysis on the Velocity and Weight Requirements (for the
Propellant). The working equations are summarized under the menu Formulas that
can be viewed or can have a printed output.

5. Attitude Control

The selection of the Attitude Control menu from the Menubar #1 will call up a set
of menus in the Menubar #6 as follows:

File Edit Attitude Control Formulas Tables

6. CC&DH

The selection of the CC&DH menu from the Menubar #1 will call up a set of menus in
the Menubar #7 as follows:

F il e Edit CC&DH Formulas Tables

The preceding two menubars, Menubar #6 and Menubar #7 are skeletal only, and no
contents have been implemented in either case. Depending on the mission and thus to
employ selected components with specific characteristics, the designs of the last two
subsystems may vary widely. No detailed functional performance analyses are
attempted for a generic spacecraft system at this stage, because the scope is just too
large to be covered. However, the ultimate cost for a specific design still can be
analyzed using any known data, either calculated or specified, through the Subsystem
Data that will be treated in detail in the next section.

C. Subsystem Data Menu

Having completed calculations on all components or subsystems (with the exception of
the last two subsystems at this point of time), the user can now enter data for individual
components through the Subsystem Data menu in the Menubar #1. Again, the user is
given four options to input, modify, view, or delete data through the Input New Data,
Modify Data, View Data, and Delete Data selections, respectively.



When entering information into the Subsystem Data for the first time, the Input
New Data is to be selected. This layout has two buttons: the OK and Cancel, and both
buttons will be activated. When modifying data, all four buttons at the bottom of the
layout will be functioning. The two additional buttons, the Save and Retrieve buttons,
operate in exactly the same manner as previously described. The Retrieve button,
however, will also retrieve the old data from the component subrecords previously
entered through the Component Data layout.

The selections of a subsystem name and its coded ID number are mandatory. The ID
numbers designated for the subsystems are as follows:

Subsystem ID Number Subsystem Name

1 Electric Power
2 Thermal control
3 Structure
4 Auxiliary Propulsion
5 Attitude Control
6 CC & DH

The user fills in the Subsystem ID Number field first by typing in the ID number;
the corresponding Subsystem Name will be entered automatically. If the user enters a
nondefined ID number in the case of a special or expanded application, the user will be
asked whether or not a new subsystem name will be created and entered into other
records relevant to the weight and cost for the undefined subsystem.

To add a picture in the Picture field, the user has to copy the picture by any available
means into the clipboard under the Edit menu before entering the 4th Dimension
database program. The user clicks on the Picture field where the region will become
highlighted, then selects the Paste from the Edit menu to transfer the stored image. It
will be automatically scaled to fit the size set out for the picture.

To enter data for each component of a subsystem, the user clicks twice at the
Component Data area within the Subsystem Data layout. It will call up a dialog box
having the title of the Component Data through which the data of the Component
Name, weight, size, and power consumption can be entered. The three buttons on the
left'hand margin labelled as Enter, Delete, and Cancel are self-explanatory. This
layout is referred to as an included layout for its inclusion within the parent layout of
the Subsystem Data. One merely repeats the process to enter data for more than one
component. The Required Power and Weight fields in the Subsystem Data layout
will use the calculated sums obtained from the component entries by clicking on the Calc
Power and Calc Wt buttons, repeatedly. However, the user can also enter data directly
at this stage.

The Known Cost field allows the user to input a specified value if the cost of a
component or a subsystem in a year, labelled as the Cost Year, is known. The user
enters the known cost and the year of that value becoming valid.

The cost estimates consist of two cost models for the protoflight and its follow-on
unit(s). Cost will be calculated as a function of weight, using the deduced empirical
expressions from flown satellites. All calculated costs are in millions of the 1980
dollars, and the NASA inflation factors will be used to convert to any year of interest.
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Thetwo constantsa and b in the empirically determined cost expressions are displayed
automatically (for verification purpose) if the weight of a subsystem does fall within its
criteron.

The three fields in the middle of the lower space in the Subsystem Data layout are the
Sum of Weights, Sum of Power, and Size. Their inputs are automatically recorded
from the results previously computed in individual subsystems, These data are
displayed for reference only; they may aid the user to compare the results of components
calculated previously. Their values cannot be altered in this layout.

Do Formats

Under the Formats menu in Menubar #1, there are three functional selections:
Summary of SiC System, Cost Models, and System Totals.

The Summary of SiC System selection will display a summary of the interested
parameters of a spacecraft system with all its subsystems and components data already
entered through the Subsystem Data layout. The weights of individual subsystems are
the ones used in the cost models. When the user clicks on the Done button at the bottom

of this layout, an option of Print will appear on the screen for selection.

The Cost Models selection will call up a dialog box that lists two options: the
Protoflight and the follow-on unit for cost estimates. The selected layout will show
on the screen. The magnitures of weight of individual subsystems are automatically
transferred from the table of the Summary of Spacecraft System. Their values, in
turn, were originally entered via the layout of the Subsystem Data. The calculated
costs of individual subsystems and the spacecraft system are in millions of the 1980
dollars. For any other years, the user needs to specify that year inside the parenthesis
in the last line of the layout. The cost will be adjusted to that year, using the NASA
inflation index. The Print button at the bottom of the screen, as an option, allows the
user to print out the results with the entire layout.

The System Totals selection will show a layout displaying various fields for the
interested parameters of the spacecraft system. They are listed clearly and are self-
explanatory. The user also has an option to print out the results of this layout.

E. Tables

Nine items are listed in this menu: Cost Constants, Inflation Factors, Physical
Constants, Weight Limits, and Modify Table with the options of View and Print
given to the first four items. The Cost Constants table displays values of a and b for
all subsystems in both the protoflight and the follow-on models. The NASA Inflation
Factors table displays the year versus the inflation factor, adopting the 1980 value as
the datum. The physical Constants table lists a number of conversions of units in
addition to some frequently used physical constants in different units. The Weight
Limits table displays the viable ranges of weight for the cost models for the individual
subsystems and the system. The last one Modify Table is a special convenience
capability permitting the user to enter several tables. It allows for expansion,
modification, or deletion of their contents without altering the programming codes.
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Menubar #1: After selecting the Custom environment, this menubar appears

File Edit Svstem Info Subsystem Data Subsy#tQms Formats Table_

Edit

Quit Show Clipboard

Subsystem Data Subsystems

Input System Info

Modify System Info

Delete System Info

InputNew Data

Modify Data
View Data

Delete Data

Electric Power

Thermal Control

Structure

Auxiliary Propulsion
Attitude Control
CC & DH

Formats

Summary of S/C System
Cost Models

System Totals

ZIb_Lu

Cost Constants

Print Cost Constants

Inflation Factors
Print Inflation Factors

Physical Constants

Print Physical Constants

Weight Limits

Print Weight Limits

Modify Table



Menubar #2: for the Electric Power subsystem

File Edit Electric Power Formulas Tables

Edit

Quit Show Clipboard

Electric Power

Input Data
View Data

Modify Data
Delete Data

Solar cell Table

Formulas

Sunlight and Eclipse Durations

Array Sizing and Weight
Temperatures

Battery Size and Weight

Menubar #3: for the Thermal Control subsystem

File Edit Thermel Formulas T¢l_les

File Edit

Quit Show Clipboard

Thermal Formulas

Input Data
View Data

Modify Data
Delete Data

Simple Space Radiator Sizing

Space Radiator Sizing
Thermal Louvers and Heaters

Conductive Paints Table

Thermal Coatings Table

Black Coatings Table
White Coatings Table

Miscellaneous Coatings

Menubar #4: for the Structure subsystem

File Edlt Structure Formulas Tables

File Edit

Quit Show Clipboard

Structure

Input Data

Modify Data

View Data

Delete Data

Formulas

Structure Variables*

Tables

Structural Material Table

* No contents being implemented.
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Menubar #5: for the Auxiliary Propulsion subsystem

File Edit Auxiliary Propulsion Formulas Tables

File Edit

Quit Show Clipboard

Aux,propulsion

Input Data
Modify Data
View Data
Delete Data

Formulas

Vel. & Weight Requirements Message*

* No contents being implemented.

Menubar #6: for the Attitude Control subsystem

File Edit Attitude Control Formulas T_bles

File Edit

Quit Show Clipboard

Attitude Control

Input Data
Modify Data
View Data
Delete Data

Formulas

Message*

Tables

Message*

* No contents being implemented.

Menubar #7: for the CC & DH subsystem

File Edit CC & DH Formul_ Tabl_,_

File Edit CC & DH

Quit Show Clipboard Input Data
Modify Data
View Data
Delete Data

* No contents being implemented.

Formulas

Message*

Tables

Message*
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